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ABSTRAK

Nama : Geovanie Lukas Wijaya
Program Studi : Teknik Sipil
Title :Analisis Keruntuhan Tekuk Struktur Bangunan Pengeringan Karet

Pembangunan di Indonesia yang berkembang pesat setiap tahunnya,
menimbulkan persaingan yang ketat di antara penyedia jasa konstruksi. Dewasa
ini, banyaknya perusahaan yang menawarkan jasa konstruksi menimbulkan
persaingan yang ketat untuk mendapatkan kepercayaan dari masyarakat agar
menggunakan jasanya. Namun terkadang dalam realitanya terjadi persaingan yang
tidak sehat, dimana terjadi perusahaan yang menawarkan jasa konstruksi yang
tidak sesuai dengan bidangnya. Hal ini menandakan masih lemahnya pengawasan
dari pemerintah terhadap perusahaan penyedia jasa konstruksi yang ada di
Indonesia, khususnya di kota — kota kecil.

Dalam penelitian ini penyusun menganalisis suatu kasus kegagalan
struktur pada bangunan pengeringan karet, yang diidentifikasikan sebagai
kegagalan tekuk pada kolom — kolomnya. Struktur bangunan dimodelkan secara
tiga dimensi dengan menggunakan program SAP2000, dan analisis yang
digunakan adalah statis nonlinear, dikarenakan tidak terjadi gempa sewaktu
struktur bangunan mengalami keruntuhan.

Dari penelitian yang dilakukan, diketahui bahwa struktur bangunan
memang tidak dapat menahan pembebanan yang direncanakan. Hal ini diperparah

dengan terjadinya korosi pada elemen — elemen struktur bangunan.

Kata Kunci:  keruntuhan tekuk, bangunan pengeringan karet, analisis statis

nonlinear
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ABSTRACT

Name :Geovanie Lukas Wijaya
Study Program:Civil Engineering
Title :Buckling Analysis of Crumb Rubber Factory Structure

Development in Indonesia is growing rapidly every year, creating intense
competition among providers of construction services. Nowadays, many
companies offering construction services create strict competition to earn public
trust to use their services. However, sometimes in practice happens unfair
competition, where company offers construction services which do not correspond
to its specialty. This indicates the weakness of government oversight of the
construction services provider company in Indonesia, especially in the small town
regions.

In this study the author analyzes a case of structural failure in the crumb
rubber factory that is identified as buckling in the columns. The building structure
is modeled in three dimensions by using SAP2000, and the analysis used is a
nonlinear static, because no earthquake occurs when the structure collapsed.

From the research conducted, it is known that structures are not able to
withstand the planned loading. This is exacerbated by the occurrence of corrosion

on the elements of building structures.

Keyword: buckling, crumb rubber factory, nonlinear static analysis
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BAB 1
PENDAHULUAN

1.1 Latar Belakang

Indonesia sebagai negara yang padat penduduknya tentu tak terhindarkan
dari pembangunan fisik yang berlangsung terus menerus. Hal ini guna memenuhi
kebutuhan manusia akan tempat tinggal, tempat untuk bekerja, dan lain
sebagainya. Oleh karenanya, tumbuh perusahaan — perusahaan baik pemerintah
ataupun swasta yang menawarkan layanan jasa konsultasi perencanaan pekerjaan
konstruksi, layanan jasa pelaksanaan pekerjaan konstruksi, dan layanan jasa
konsultasi pengawasan pekerjaan konstruksi.

Dewasa ini, banyaknya perusahaan yang menawarkan jasa konstruksi
menimbulkan persaingan yang ketat untuk mendapatkan kepercayaan dari
masyarakat agar menggunakan jasanya. Namun terkadang dalam realitanya terjadi
persaingan yang tidak sehat, dimana terjadi perusahaan yang menawarkan jasa
konstruksi yang tidak sesuai dengan bidangnya. Padahal dalam Undang-Undang
Nomor 18 Tahun 1999 tentang Jasa Konstruksi sudah diatur masalah perizinan
bagi penyedia jasa konstruksi. Hal ini menandakan masih lemahnya pengawasan
dari pemerintah terhadap perusahaan penyedia jasa konstruksi yang ada di
Indonesia.

Belum lama ini, pada tanggal 21 Mei 2010, terjadi kegagalan struktur
pada sebuah bangunan pengeringan getah karet yang mengakibatkan bangunan
tersebut roboh. Sudah tentu kejadian ini tidak perlu terjadi jika penyedia jasa
konstruksi menjalankan tugasnya dengan baik dengan mengikuti standar — standar

yang telah ditetapkan.
1.2 Maksud dan Tujuan Penelitian
Maksud dari penulisan skripsi ini adalah mensimulasikan dan

menganalisis keruntuhan tekuk yang terjadi struktur bangunan pengeringan karet.

Untuk perencanaan strukturnya, karena material utama yang digunakan untuk

1 Universitas Indonesia
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struktur bangunan pengeringan karet adalah baja, maka menggunakan SNI 03-
1729-2002. Sedangkan untuk pembebanannya menggunakan SKBI — 1.3.53.1987.

Tujuan dari penulisan skripsi ini adalah untuk mendapatkan pemodelan
keruntuhan tekuk struktur bangunan pengeringan karet di Palembang. Topik dari
penulisan skripsi ini adalah Analisis Keruntuhan Tekuk Struktur Bangunan

Pengeringan Karet.

1.3 Manfaat Penelitian

Manfaat dari penulisan skripsi ini adalah agar mahasiswa mengerti salah
satu contoh kegagalan struktur pada bangunan, dalam hal ini adalah keruntuhan
tekuk. Dalam penulisan skripsi ini, kasus keruntuhan tekuk yang kemudian
disimulasi dan dianalisis merupakan kasus nyata yang terjadi pada suatu bangunan
pengeringan karet yang ada di Indonesia. Jadi skripsi ini merupakan sebuah
persiapan akhir bagi mahasiswa, jika nantinya setelah lulus akan bekerja dalam

bidang yang menyangkut permasalahan struktur bangunan.

1.4 Batasan Penelitian

Dalam penulisan skripsi ini, bangunan yang disimulasikan dan dianalisis
keruntuhan tekuknya adalah hanya bangunan pengeringan karet saja. Struktur
kolom dalam bangunan pengeringan karet ini menggunakan material baja. Untuk
setiap sambungan baja pada bangunan pengeringan karet ini diasumsikan
menggunakan jenis sambungan baut dan sambungan las.

Analisis keruntuhan tekuk pada bangunan pengeringan karet ini tidak
menggunakan analasi dinamik, karena keruntuhan tekuk yang terjadi pada

bangunan ini tidak diakibatkan oleh gempa, tetapi oleh beban gravitasi saja.

1.5 Sistematika Penulisan
Sistematika penulisan skripsi ini terdiri dari 5 (lima) bab, antara lain:
BAB 1 : PENDAHULUAN
Bab ini membahas mengenai latar belakang, maksud dan
tujuan, pembatasan masalah, metodologi penulisan, dan

sistematika penulisan.

Universitas Indonesia
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BAB 2

BAB 3

BAB 4

BAB 5

LITERATUR REVIEW

Bab ini membahas mengenai dasar teori kegagalan struktur
bangunan yang berupa keruntuhan tekuk dan juga dasar
teori mengenai jenis — jenis sambungan yang digunakan
dalam perencanaan suatu struktur bangunan. Lalu juga akan
ada pembahasan mengenai peraturan — peraturan yang
berhubungan dengan perencanaan struktur yang mengalami
pembebanan tekan, berdasarkan SNI 03-1729-2002
(Standar Nasional Indonesia) Tata Cara Perencanaan
Struktur Baja untuk Bangunan Gedung.

METODELOGI PENELITIAN

Bab ini membahas mengenai urutan metode berserta
penjabarannya di dalam mensimulasikan dan menganalisis
Keruntuhan Tekuk Struktur Bangunan Pengeringan
Karet.

ANALISIS KERUNTUHAN TEKUK PADA
BANGUNAN PENGERINGAN KARET

Bab ini membahas mengenai analisis keruntuhan tekuk
pada bangunan pengeringan karet. Perhitungan perilaku
struktur bangunan pengeringan Kkaret ini dilakukan dengan
program komputer.

KESIMPULAN DAN SARAN

Bab ini berupa kesimpulan dan saran mengenai analisis
keruntuhan tekuk pada bangunan pengeringan Kkaret
mengacu pada hasil analisis pemodelan yang telah
dilakukan.

Universitas Indonesia
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BAB 2
LITERATUR REVIEW

2.1 Keruntuhan Tekuk

Dalam skripsi ini akan disimulasikan dan dianalisis mengenai
kegagalan struktur pada suatu bangunan pengeringan getah karet, yaitu berupa
keruntuhan tekuk pada kolom — kolomnya. Kolom didefinisikan sebagai suatu
member yang panjang dan langsing yang menerima suatu gaya tekan aksial,
sedangkan tekuk merupakan defleksi lateral yang terjadi pada sebuah kolom
akibat diberi pembebanan aksial. Keruntuhan tekuk yang terjadi pada suatu kolom
biasanya terjadi secara tiba — tiba.

Gaya aksial maksimum yang dapat ditanggung oleh sebuah kolom ketika
kolom tersebut berada dalam batas keruntuhan tekuknya disebut dengan beban
kritis (Pcr). Jika kolom dimodelkan sebagai dua buah member yang diasumsikan
tidak bermassa dan kaku, yang pada bagian ujung-ujungnya terhubung dengan
menggunakan sebuah pin, dan pada bagian yang terhubung ini dipasang sebuah
pegas dalam arah lateral, seperti pada gambar berikut:

Pt

Gambar 2. 1 Pemodelan sederhana tekuk pada kolom

4 Universitas Indonesia
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diketahui besarnya beban kritis kolom tersebut yaitu:

kL

P, = T

dimana: Kk adalah kekakuan pegas
L adalah panjang kolom tersebut.

Pada tahun 1757, Leonhard Euler melakukan pemodelan kolom dengan
lebih ideal lagi untuk mencari besarnya beban kritis suatu kolom. Euler
memodelkan sebuah kolom sebagai sebuah member vertikal yang pada bagian
pangkalnya dipasang perletakan sendi, dan bagian ujungnya, bagian yang
menerima pembebanan aksial, dipasang perletakan rol, yaitu seperti gambar
berikut:

—
-
=

~
&

&=

Gambar 2. 2 Pemodelan Euler untuk tekuk pada kolom

dengan pemodelan kolom yang dilakukan oleh Euler ini didapatkan besarnya
beban kritis adalah:

m2EIl
Ccr LZ
dimana; E adalah modulus elastisitas dari kolom

I adalah momen inersia terkecil yang dimiliki oleh
penampang kolom

L adalah panjang kolom

Universitas Indonesia
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Dari beban kritis ini, Kita bisa mendapatkan besarnya tegangan kritis, yaitu:
_ m’E
—(L/r)?

dimana o, adalah tegangan kritis kolom sebelum kolom tersebut mengalami

O-C T

keruntuhan tekuk, dimana tegangan ini merupakan tegangan yang elastis,
sehingga o, < gy (tegangan leleh) ; r adalah adalah jari — jari girasi terkecil dari

suatu kolom, dan besarnya jari — jari girasi ini dapat dicari dengan rumus r =

\/I/_A. Rasio L/r ini dikenal juga dengan istilah rasio kelangsingan kolom, yang
digunakan untuk mengukur fleksibilitas suatu kolom, dan menentukan klasifikasi
suatu kolom, yaitu sebagai kolom panjang, sedang, atau pendek.

Pemodelan yang dilakukan oleh Euler hanya terbatas pada suatu kolom
yang dimodelkan sebagai member dengan pangkal dipasang perletakan sendi dan
ujungnya dipasang perletakan rol. Untuk pemodelan kolom dengan ujung dan
pangkal yang berbeda — beda jenis perletakannya, akan didapatkan besarnya

beban kritis adalah:

m2EIl
fo = L7
dan besarnya tegangan Kritis, yaitu:
b s
%er = KL/7)?

Dimana K adalah faktor panjang efektif, yang didefinisikan sebagai L, = KL,

sedangkan (KL /r) adalah rasio kelangsingan efektif suatu kolom.

2.2 Sambungan
2.2.1 Sambungan Baut
Suatu baut yang memikul beban terfaktor, Ry, sesuai LRFD harus memenubhi:
R, < 0.R,
dengan R, adalah tahanan nominal baut sedangkan @ adalah faktor reduksi
sebesar 0,75.
2.2.1.1 Kuat Nominal Baut

e Tahanan Geser Baut
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Tahanan nominal satu buah baut yang memikul gaya geser memenuhi

persamaan:
R,=m.r.fl. 4,
dimana: m adalah jumlah bidang geser
r besarnya 0,5 untuk baut tanpa ulir; 0,4 untuk baut dengan
ulir

f,°  adalah kuat tarik baut
Ab  adalah luas bruto penampang baut pada daerah tak berulir
e Tahanan Tarik Baut
Baut yang memikul gaya tarik tahanan nominalnya dihitung menurut:
R, = 0,75. £ A3

e Tahanan Tumpu Baut
Tahanan tumpu nominal tergantung kondisi yang terlemah dari baut atau
komponen pelat yang disambung. Besarnya ditentukan sebagai berikut:
R, =24.dy.tp.fy
dimana: dp adalah diamete baut pada daerah tak berulir
ty adalah tebal pelat
1 adalah kuat tarik putus terendah dari baut atau pelat
Dalam SNI pasal 13.4 diatur mengenai tata letak baut. Jarak antar pusat
lubang baut harus diambil tidak kurang dari 3 kali diameter nominal baut, dan
jarak antara baut tepi dengan ujung pelat harus sekurang — kurangnya 1,5
diameter nominal baut. Dan jarak maksimum antar pusat lubang baut tak boleh
melebihi 15 t, ( dengan t, adalah tebal pelat tertipis dalam sambungan) atau 200
mm, sedangka jarak tepi maksimum harus tidak melebihi (4 t, + 100 mm) atau
200 mm.
e Sambungan Tipe Friksi
Apabila dikehendaki sambungan tanpa slip, maka satu baut yang hanya
memikul gaya geser terfaktor, V,, dalam bidang permukaan friksi harus
memenuhi:
V, <V,
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dimana: V; = @.V,, adalah kuat geser satu baut dalam sambungan tipe friksi
yang besarnya dihitung menurut:
Vy=0.V, =113.0.u.m.proof load
dimana: v adalah koefisien gesek yang besarnya 0,35
adalah jumlah bidang geser
@ besarnya 1,0 untuk lubang standar; 0,85 untuk lubang selot
pendek dan lubang besar; 0,70 untuk lubang selot panjgang
tegak lurus arah gaya; dan 0,60 untuk lubang selot panjang

sejajar arah gaya

2.2.2 Sambungan Las

2.2.2.1 Jenis — Jenis Sambungan

Jenis — jenis sambungan yang umum dijumpai pada sambungan las antara lain:

a) Sambungan Sebidang (butt joint), sambungan yang umum dipakai untuk pelat
— pelat datar dengan ketebalan sama atau hampir sama, keuntungan
sambungan ini adalah tak adanya eksentrisitas. Ujung — ujung yang yang
hendak disambung harus dipersiapkan terlebih dahulu (diratakan atau
dimiringkan) dan elemen yang disambung harus dipertemukan secara hati —
hati.

b) Sambungan Lewatan (lap joint), jenis sambungan yang paling banyak
dijumpai karena sambungan ini mudah diseuaikan keadaan di lapangan dan
juga penyambungannya relative lebih mudah. Juga cocok untuk tebal pelat
yang berlainan.

c) Sambungan Tegak (tee joint), sambungan ini banyak dipakai terutama untuk
membuat penampang tersusun seperti bentuk I, dan pelat girder.

d) Sambungan Sudut (corner joint), dipakai untuk penampang tersusun
berbentuk kotak yang digunakan untuk kolom atau balok yang menerima gaya
torsi yang besar.

e) Sambungan Sisi (edge joint), sambungan ini bukan jenis struktural dan
digunakan untuk menjaga agar dua atau lebih pelat tidak bergeser satu dengan

yang lainnya.
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(a) butt joint (b) lap joint

(c) tee joint (d) comer joint (e) edge joint

Gambar 2. 3 Tipe — tipe sambungan las

2.2.2.2 Jenis — Jenis Las

Jenis — jenis las yang sering dijumpai, antara lain:

a)

b)

Las Tumpul (groove welds), adalah tipe las yang dipakai untuk menyambung
batang — batang sebidang, karena las ini harus menyalurkan secara penuh
beban yang bekerja, maka las ini harus memiliki kekuatan yang sama dengan
batang yang disambungnya.

Las Sudut (fillet welds), adalah tipe las yang paling umum dijumpai. Dalam
pelaksanaannya tidak memerlukan presisi yang tinggi.

Las Baji dan Las Pasak (slog and plug welds), adalah tipe las yang biasa
digunakan bersamaan dengan las sudut. Manfaat utamanya adalah
menyalurkan gaya geser pada sambungan lewatan bila ukuran panjangn las

terbatas oleh panjang yang tersedia untuk las sudut.

2.3 Peraturan Mengenai Komponen Struktur Tekan

Dalam perencanaan struktur kolom yang menggunakan material baja,

mengacu pada SNI 03-1729-2002 (Standar Nasional Indonesia) Tata Cara

Perencanaan Struktur Baja untuk Bangunan Gedung, pada butir 7.6 dibahas

mengenai analisis tekuk komponen struktur, yaitu sebagai berikut:
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a. Gaya tekuk elastis

Gaya tekuk elastis komponen struktur (N) ditetapkan sebagai berikut:

Ap. f;
Ng = 12 Y
¢

dengan parameter kelangsingan kolom, 4., ditetapkan sebagai berikut:

1L, |fy
: —;?J;

C

dengan L = k..L dan f, adalah tegangan lelen material, sedangkan k.

adalah faktor panjang tekuk.

b. Daya dukung nominal komponen struktur tekan
Untuk penampang yang mempunyai perbandingan lebar terhadap tebalnya
lebih kecil daripada nilai A, pada tabel, daya dukung nominal komponen

struktur tekan dihitung sebagai berikut:

f

N = A, = Ag.ay
untuk A, <0,25 maka w =1
untuk 0,25<1,.<1,2 maka @ = —=o

1,6—0,67

untuk A, >1,2 maka o = 1,251,.°
keterangan:
A adalah luas penampang brutto (mm?)

for adalah tegangan kritis penampang (MPa)
fy adalah tegangan leleh material (MPa)

Untuk penampang yang mempunyai perbandingan lebar terhadap
tebalnya lebih besar daripada nilai A, pada tabel, analisis kekuatan dan
kekakuannya dilakukan secara tersendiri dengan mengacu pada metode — metode
analisis yang rasional.

1. Faktor panjang tekuk

Nilai faktor panjang tekuk (k.) bergantung pada kekangan rotasi dan

translasi pada ujung — ujung komponen struktur. Untuk komponen struktur tekan

yang merupakan bagian dari suatu rangka bersambungan kaku, nilai faktor
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panjang tekuk (k.) ditetapkan untuk komponen struktur tak — bergoyang dan
untuk komponen struktur bergoyang. Ga dan Gg adalah perbandingan antara
kekakuan komponen struktur dengan tekan dominan terhadap kekakuan
komponen struktur relative bebas tekan, masing — masing pada ujung A dan ujung
B. Nilai G suatu komponen struktur ditentukan sebagai berikut:

2(),

Y

kecuali bahwa:

i.  Untuk komponen struktur tekan yang dasarnya tidak terhubungkan secara
kaku pada fondasi, nilai G tidak boleh diambil kurang daru 10, kecuali bila
dilakukan analisi khusus untuk menetapkan nilai G tersebut; dan

ii.  Untuk komponen struktur tekan yang dasarnya terhubungkan secara kaku
pada fondasi, nilai G tidak boleh diambil kurang dari 1, kecuali bila

dilakukan analisis khusus untuk menetapkan nilai G tersebut.

Besaran Z(%) dihitung dengan menjumlahkan kekakuan semua komponen
C

struktur tekan — dengan bidang lentur yang sama — yang terhubungkan secara

kaku pada ujung komponen struktur yang sedang ditinjau, termasuk komponen
struktur itu sendiri. Besaran Z(%)b dihitung dengan menjumlahkan kekakuan
semua komponen struktur lentur — dengan bidang lentur yang sama — yang

terhubungkan secara kaku pada ujung komponen struktur yang sedang ditinjau.

Universitas Indonesia

Analisis keruntuhan ..., Geovanie Lukas Wijaya, FT Ul, 2011



12

= —
(a) () {c) (d) (¢ (t)
L AN
1 ( 7] Tl T ,P .€.|
H ] H . 7 i
Garis terputus menunjukkan I'I ! ,fl ) i ;
diagram kolom tertekuk i H / \ H ,"
] ) 1
R RN
v ' g 4 )
\\ 1 t
i b [ I
Nilai 4, teoritis . 0.5 0.7 1.0 1.0 2.0 20
Nilai 4c yang dianjurkan untuk .
licé:ilj?m vang mendeckati kondisi 0.65 0.80 1.2 1.0 210 2.0
“T‘l‘ Jepit
"?‘ Sendi
Kod g
e ujung Eiﬂ Roll tanpa putaran sudut
T Ujung bebas

Gambar 2. 4 Nilai k; untuk kolom dengan ujung — ujung yang ideal
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Gambar 2. 5 (a) Nilai k; untuk komponen struktur tak bergoyang; (b) untuk
komponen struktur tak bergoyang.
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2. Batas kelangsingan

Untuk batang — batang yang direncanakan terhadap tekan, angka
perbandingan kelangsingan A = L, /r dibatasi sebesar 200. Untuk batang — batang
yang direncanakan terhadap tarik, angka perbandingan kelangsingan L/r dibatasi
sebesar 300 untuk batang sekunder dan 240 untuk batang primer. Ketentuan di
atas tidak berlaku untuk batang bulat dalam tarik. Batang — batang yang
ditentukan oleh gaya tarik, namun dapat berubah menjadi tekan yang tidak
dominan pada kombinasi pembebanan yang lain, tidak perlu memenuhi batas

kelangsingan batang tekan.
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Tabel 2. 1 Perbandingan Maksimum Lebar terhadap Tebal untuk Elemen Tertekan

14

Jenis Elemen

Perbandingan lebar
terhadap tebal A

Perbandingan maksimum lebar terhadap tebal

Ap (kompak)

A, (tak — kompak)

Pelat sayap balok | dank anal dalam lentur

Elemen tanpa pengaku

profil siku dan plat yang menyatu dengan
balok atau komponen struktur tekan.

b/t 170/.[7, [c] 370/ |f, — fr
Pelat saya balok I hibrida atau balok tersusun 420
. b/t 170
yang dilas dalam lentur / fyr /(fy _ fr)/ke
Pelat sayap dari komponen — komponen
b/t - 290/ |f,/ke
struktur terstruktur dalam tekan.
Sayap bebas dari profil siku kembar yang
menyatu pada sayap lainnya, pelat sayap dari
komponen struktur kanal dalam aksial tekan, b/t - 250/ |f,
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Sayap dari profil siku tunggal pada
penyokong, sayap pada profil siku ganda
dengan pelat kopel pada penyokong, elemen
yang tidak diperkaku, yaitu, yang ditumpu

pada salah satu sisinya.

b/t -

200/ [f,

Pelat badan dari profil T.

d/t =

355/ [f,

Pelat sayap dari penampang persegi panjang
dan bujursangkar berongga dengan ketebalan
seragam yang dibebani lentur atau tekan;
pelat penutup dari pelat sayap dan pelat
diafragma yang terletak di antara baut — baut

atau las

b/t 500/ |fy

625/ [f,

Elemen dengan Pengaku

Bagian lebar yang tak terkekang dari pelat
penutup berlubang [b]

b/t -

830/ [f,

Bagian — bagian pelat badan dalam tekan

h/t 1680/./f, [c]

2550//fy [d]
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akibat lentur [a]

Bagian — bagian pelat badan dalam kombinasi h/ty Untuk: [0]
tekan dan lentur
N./®pN, < 0,125[c] 2550 y ll 0,74Nul
N
1680 " 0,74Nul
N bply
Untuk:
Ny/$pN,, > 0,125[c]
500 0,74N,| 655
===P"3 3= >
VI $uNy 17 Ky
Elemen — elemen lainnya yang diperkaku bit
dalam tekan murni; yaitu dikekang sepanjang 665/ fy
h/ty

kedua sisinya
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Penampang bulat berongga: [d]
Pada tekan aksial Dt - 22000/,
Pada lentur 14800/, 62000/,

[a] Untuk balok hibrida, gunakan tegangan leleh pelat sayap fy sebagai | [e] f,- = tegangan tekan residual pada pelat sayap

anti fy.
ganti ty = 70 MPa untuk penampang dirol

[b] Ambil luas netto plat pada lubang terbesar )
= 115 MPa untuk penampang dilas

[c] Dianggap kapasitas rotasi inelastic sebesar 3. Untuk struktur —

[f]l k. = J%/_t dengan: 0,35 < k, < 0,763

struktur pada zona gempa tinggi diperlukan kapasitas rotasi yang lebih

besar. .
[0] f, adalah tegangan leleh minimum.

[d] Untuk perencanaan plastis gunakan 9000/ f,
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Sedangkan pada pasal 9 dalam SNI 03-1729-2002 (Standar Nasional
Indonesia) Tata Cara Perencanaan Struktur Baja untuk Bangunan Gedung,
dibahas mengenai komponen struktur tekan, yaitu sebagai berikut:

1) Perencanaan akibat gaya tekan
Suatu Komponen Struktur yang mengalami gaya tekan konsentris akibat

beban terfaktor, Ny, harus memenuhi persyaratan sebagai berikut:

a) N, <0,.N,
Keterangan:
Dn adalah faktor reduksi kekuatan
N, adalah kuat tekan nominal komponen struktur

b) Perbandingan kelangsingan

- Kelangsingan elemen penampang < A, (lihat tabel 7.5-1)
- Kelangsingan komponen struktur tekan, 4 = Lr—" < 200

c) Komponen struktur tekan yang elemen penampangnya mempunyai
perbandingan lebar terhadap tebal lebih besar daripada nilai A, yang
ditentukan dalam tabel 7.5-1 harus direncanakan dengan analisis rasional
yang dapat diterima.

2) Kuat tekan rencana akibat tekuk lentur-torsi

Kuat tekan rencana akibat tekuk lentur-torsi, @,.N,; dari komponen
struktur tekan yang terdiri dari siku-ganda atau berbentuk T, dengan elemen —
elemen penampangnya mempunyai rasio tebal, 4, lebih kecil daripada yang

ditentukan dalam tabel 7.5-1 harus memenubhi:

Nu = (Dn- ant
dengan @,, adalah faktor reduksi kekuatan (lihat tabel 6.4-2)
Ny = Ag-fclt
fcry + fcrz 4. fcry- fcrz- H
far = T e
(fery + forz)
. . G.J
dimana: ferz = yr=
dengan: e adalah jari — jari girasi polar terhadap pusat geser.
L +1
o =" +x3+¥5
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x2+2
H:1_<OQ%>

7o
keterangan:
X0, Vo adalah koordinat pusat geser terhadap titik berat, X, = 0 untuk siku
ganda dan profil T (sumbu y — sumbu simetris)
fery dihitung sesuai dengan persamaan f, :% ; untuk lentur terhadap

sumbu lemah y-y, dan dengan menggunakan harga , A., yang
dihitung dengan rumus:
il . il f_y

=
.17, E

dengan Ly adalah panjang tekuk dalam arah sumbu lemah y-y.

Pada butir 15.6.1 dalam SNI 03-1729-2002 (Standar Nasional Indonesia)
Tata Cara Perencanaan Struktur Baja untuk Bangunan Gedung, dikatakan kolom
untuk sistem rangka tahan gempa harus memenuhi syarat:
N,/®N,, > 0,4
Pada butir 15.6.1.1 juga dijelaskan mengenai besarnya gaya tekan
terfaktor kolom yang dapat menyebabkan terjadinya tekuk pada struktur kolom,
tanpa adanya pengaruh dari momen — momen yang bekerja, yaitu ditetapkan
berdasarkan kombinasi persamaan:
N, =12D + y,L + QoE; :
dimana:
D adalah pengaruh beban mati yang disebabkan oleh berat elemen struktur
dan beban tetap pada struktur
L adalah pengaruh beban hidup akibat pengguna gedung dan peralatan
bergerak;
E, adalah pengaruh dari komponen horizontal gaya gempa
Qo adalah faktor kuat cadang struktur.
Berikut merupakan peraturan lain yang digunakan untuk
mendukung dalam mensimulasikan dan menganalisis Keruntuhan Tekuk Struktur

Bangunan Pengeringanan Karet:
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SKBI - 1.3.53.1987, membahas mengenai Pedoman Perencanaan
Pembebanan untuk Rumah dan Gedung. Sebagai panduan perencanaan

pembebanan untuk bangunan pengeringan karet.
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BAB 3
METODOLOGI PENELITIAN

3.1 Rencana Penelitian

Penelitian ini seluruhnya akan dilakukan dengan menggunakan bantuan
program komputer. Penelitian ini meliputi pengumpulan data — data teknis dari
struktur bangunan, pemodelan struktur bangunan, dan pemodelan dari keruntuhan
tekuk struktur kolomnya.

Pemodelan dilakukan sebanyak dua buah. Pemodelan pertama (Model I)
berupa pemodelan bangunan menurut kondisi eksistingnya, sedangkan pemodelan
kedua (Model II) berupa pemodelan bangunan menurut shop drawing-yang
terdapat didalam IMB bangunan tersebut. Pemodelan dilakukan dengan
menginput data — data teknis dari struktur bangunan pengeringan karet ini ke
dalam program komputer SAP2000. Data — data teknis ini berupa denah struktur
bangunan pengeringan karet, spesifikasi material yang digunakan, detail profil
elemen — elemen struktur bangunan, dan pembebanan yang diterima oleh struktur
bangunan. Data — data teknis dari struktur bangunan pengeringan Kkaret ini
semuanya berasal dari perusahaan konsultan struktur PT. Rekatama
Konstruksindo.

Pemodelan keruntuhan tekuknya akan dilakukan dengan cara
memberikan pembebanan secara kontinu kepada struktur bangunan yang sudah
dimodelkan juga sebelumnya, sampai pada batas pembebanan ultimitnya, agar
jejak keruntuhan tekuknya dapat terekam.

Kemudian hasil yang didapatkan dari kedua pemodelan, akan dilakukan
analisis mengenai proses terjadinya keruntuhan tekuk pada bangunan pengeringan

karet tersebut.
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Berikut merupakan diagram alir dari metodelogi penelitian skripsi ini:

=

< STUGH LITERATLIR >
¥

/ FEMGUMFPLULAN DATA /

FEMGOLAHAMN DATH

FEMODELAN

AMALISA HASIL PEMODELAN

e
()

Gambar 3. 1 Diagram Alir Metodelogi Penelitian
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3.2 Pelaksanaan
3.2.1 Data — Data Teknis Struktur Bangunan Pengeringan Karet

a. Gambar potongan struktur bangunan
Berikut adalah gambar potongan struktur bangunan yang akan

dianalisis keruntuhan tekuknya:
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' | w0
. %

Tz ! . M‘

G
I
3<

Coeraotityn

= tF 250(typ |

' ; = 3
[l | S mAW$M‘L%W$M‘
&’%%‘é’é’o ©® ®

/K y P L ngap M . ’ 3

Gambar 3. 2 Potongan memanjang
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Gambar 3. 3 Potongan melintang
Berikut merupakan spesifikasi dimensi bangunan pengeringan karet:
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Panjang bangunan  :40m

Lebar bangunan 124 m
Tinggi bangunan 122,84 m
Jumlah lantai - 4 lantal
Tinggi lantai 4 m (tipikal)
Lebar balok : 4 m (tipikal)

b. Spesifikasi kekuatan material
Untuk Model Il, menggunakan mutu baja rencana BJ 37 dengan

spesifikasi sebagai berikut:

Kuat tarik min. (fu) : 370 MPa
Kuat leleh min. (fy) : 240 MPa
Modulus elastisitas (E) : 2,1.10° kg/cm?

Sementara untuk Model I menggunakan mutu material baja hasil uji tarik, yaitu
sebagai berikut:
Tabel 3. 1 Nilai Mutu Material Baja Hasil Uji Tarik

Tipe Baja fu (Mpa) fy (MPa)
WF 250x125x6x9 480 330
WEF 200x100x5,5x8 420 330
WEF 150x75x5x7 560 410
Siku 50x50x5 660 470

Dikarenakan yang digunakan sebagai elemen utama struktur bangunan tersebut
adalah tipe baja WF 250x125x6x9 dan WF 200x100x5,5x8; maka mutu material

yang digunakan akan disederhanakan ke dalam satu nilai, yaitu sebagai berikut:

Kuat tarik min. (fu) : 450 MPa
Kuat leleh min. (fy) : 330 MPa
Modulus elastisitas (E) : 2,1.10° kg/cm?

c. Detail profil penampang elemen — elemen struktur
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Untuk detail profil penampang elemen — elemen struktur, ada dua acuan
data yang digunakan. Acuan data yang pertama adalah shop drawing yang
terdapat pada IMB bangunan dan acuan data yang kedua adalah hasil
pengukuran langsung elemen — elemen struktur bangunan tersebut. Pengukuran
langsung dirasa perlu dilakukan karena kondisi elemen — elemen struktur yang
sudah terkorosi. Pengukuran langsung elemen struktur yang berupa kolom dan
balok ini dilakukan secara acak, yang kemudian hasilnya dirata-ratakan menjadi
satu nilai agar ketika dimodelkan menjadi lebih mudah, yaitu sebagai berikut:

Tabel 3. 2 Detail Elemen Struktur Kolom dan Balok

Elemen Struktur Shop Drawing Kondisi Eksisting
Kolom WF 250x125x6x9 WF 250x125x(4)x(6)
Balok WEF 200x100x5,5x8 WF 200x100x(4,5)x(7)

Gambar 3. 4 Foto kolom yang telah berkarat
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Gambar 3. 5 Foto elemen — elemen struktur baja lainnya yang telah

berkarat

Untuk Model I profil penampang kolom dan baloknya didasarkan dari
pengukuran langsung di lapangan, sementara untuk Model Il didasarkan dari apa
yang tertera pada shop drawing-nya. Sedangkan untuk elemen — elemen struktur
lainnya yang tergolong kecil, baik pemodelan pertama maupun pemodelan
kedua, profil penampangnya didasarkan pada shop drawing yang terdapat pada

IMB bangunan pengeringan karet tersebut, yaitu sebagai berikut:

Tabel 3. 3 Detail Elemen Struktur Lainnya

Elemen Struktur Tipe Baja
Kanopi Siku 50x50x5
Gording Channel 100x50x2,3
Kuda — kuda WEF 150x75x5x7
Pipe Support Pipe 3"
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Bila diringkaskan, maka perbedaan Model | dan Model 1l adalah sebagai berikut:

Tabel 3. 4 Tabulasi Spesifikasi Model | dan Model 11

ITEM MODEL I MODEL 11
Denah Struktur _ ) _ ]
Dari Shop Drawing Dari Shop Drawing
Bangunan
Profil Penampang Dari Shop Drawing dan
Elemen — Elemen pengukuran langsung di Dari Shop Drawing
Struktur lapangan
i e Mutu Baja Rencana
Mutu Material Mutu Baja hasil uji tarik -

3.2.2 Konfigurasi Pembebanan pada Struktur Bangunan
a. Pembebanan Struktur Bangunan
Beban mati didefinisikan berdasarkan ketentuan dalam pedoman
perencanaan pembebanan untuk rumah dan gedung 1987, sebagai berikut:
Beban mati pada struktur
Berat sendiri material baja : 7850 kg/m*
Berat sendiri material kayu : 1000 kg/m?
Beban hidup
Beban crumb rubber (karet) : 27 kg/lembar
Analisis pembebanannya sendiri adalah sebagai berikut:
Beban mati:
Berat kayu = 1000 kg/m3
Jumlah reng = 10 buah/m
Panjang reng = 1,33 m antar tumpuan
Berat reng 5/7 = 0,05 x 0,07 X 1,33 x 10 X 1000 = 46,55kg/m’
Berat kaso 6,5/13,5 = 0,065 X 0,13,5 x 1000 = 8,8kg/m’

Total berat karet:
Untuk pipe support sisi dalam = 46,55 + 8,8 = 55,4 kg/m
= 0,554 N/mm
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Untuk pipe support sisi tepi = 46,55/2 + 8,8 = 32,1 kg/m
= 0,321 N/mm
Beban hidup:
Berat karet (hasil timbang) = 27 kg/1lembar
Jumlah karet = 20 lembar/m (2 X 10lembar dalam satu lajur reng)
Total berat karet:
Untuk pipe support sisi dalam = 27kg x 20 = 540 kg/m = 5,4 N/mm
Untuk pipe support sisi tepi = 27kg X 10 = 270 kg/m = 2,7N/mm

Gambar 3. 6 Foto pembebanan lembaran karet mentah dari gedung pengeringan

karet lainnya yang tipikal
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Gambar 3. 7 Denah tipikal platform dan potongan

Beban sementara (angin)

Sesuai dengan pedoman perencanaan pembebanan untuk rumah dan
gedung (SKBI-1.3.53.1987), tekanan tiup angin harus diambil minimum 25
kg/m? namun untuk daerah — daerah tertentu dimana kecepatan angin mungkin
menghasilkan tekanan tiup yang lebih besar, maka tekanan tiupnya dapat dihitung
sebagai berikut:

p=VZ%/16

dengan p adalah tekanan tiup (kg/m?) dan V adalah kecepatan angin (m/s).

Berdasarkan data kecepatan angin yang diamati dari Stasiun Meteorologi
terdekat dari lokasi bangunan pengeringan karet tersebut, kecepatan angin
maksimum adalah sebesar V = 40 km/jam (11,11 m/s), sehingga besar tekanan
tiup maksimum diperoleh sebesar:

p = (11,11)2/16 = 7,72kg/m? < 25 kg/m?

tekanan tiup di atas masih jauh di bawah tekanan tiup minimum (25 kg/m?),

sehingga dapat disimpulkan bahwa beban angin pengaruhnya relatif kecil.
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b. Kombinasi Pembebanan
Analisis struktur dilakukan berdasarkan kombinasi gaya dalam akibat
masing — masing pembebanan. Kombinasi pembebanan untuk analisis struktur ini
adalah sebagai berikut:
Kombinasi beban tetap
1. qu=14qp,
2. qy =12qp, +1,6q,, +0,5q14
3. qu=12qp, +1,6q14 + 191,
Kombinasi beban sementara
1. qu = 0,9qp; = 1,3qw
2. qu = 1,2qp; +7q, + 0,5q14 = 1,3qy
dimana: qp.  adalah beban mati
q.,  adalah beban hidup platform
q.q  adalah beban hidup atap
qw  adalah beban angin
T =0,5 (bila q;;, < 5kPa)
=1,0 (bila g, = 5kPa)
c. Kriteria Keamanan pada Konsep PBKT (Perancangan berdasarkan
Beban dan Kekuatan Terfaktor)

Kriteria keamanan pada konsep PBKT (Perancangan berdasarkan Beban
dan Kekuatan Terfaktor) ditetapkan dengan memenuhi pertidaksamaan:
M, < ¢.M,
=@V
N, < ¢.N,

dimana: adalah momen lentur ultimit

=X

adalah gaya geser ultimit

z =

<

adalah gaya normal ultimit

adalah momen lentur nominal

=

adalah gaya geser nominal

z =

n adalah gaya normal nominal

adalah faktor reduksi kekuatan

©-
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Faktor reduksi kekuatan ¢

Analisis lentur murni 0,90
Analisis normal tarik 0,90
Analisis normal tekan 0,90
Analisis lentur dengan normal tekan 0,90
Analisis geser : 0,75

3.2.3 Analisis Struktur dengan Metode Elemen Hingga

Untuk mendapatkan gaya dalam yang terjadi pada semua komponen
struktur akibat kombinasi beban rencana, digunakan Metode Elemen Hingga
(Finite Element Method).

Metode Elemen Hingga adalah suatu prosedur numerik untuk
menganalisis dan menyelesaikan sebuah persoalan mekanika teknik, dengan sifat
material diasumsikan berperilaku elastik linear. Dalam metode ini, sistem struktur
telah dibagi menjadi elemen — elemen satuan, di mana elemen yang satu dengan
yang lainnya dihubungkan oleh titik nodal. Selanjutnya, derajat kebebasan
(degree of freedom) titik — titik nodal ini sedapat mungkin dibuat kompatibel dan
didefinisikan sesuai dengan kondisi batas dari sistem struktur yang sebenarnya.

Untuk mendapatkan model struktur yang mendekati kenyataan, maka
elemen — elemen yang telah digabung tersebut secara mekanika harus memenuhi
persyaratan — persyaratan berikut ini:

- Keseimbangan gaya luar dan gaya dalam

- Material struktur dan deformasinya harus memenuhi suatu hukum sifat bahan,
yang dalam hal ini telah diasumsikan sebagai elastis linear

- Kontinuitas deformasi antara dua elemen yang bersebelahan pada satu titik
nodal, atau dengan titik tumpuan (syarat batas), yang disebut sebagai syarat
kompatibilitas

Dalam analisis ini, semua langkah — langkah perhitungan yang
menggunakan Metode Elemen Hingga akan dilakukan menggunakan program
analisis structural SAP2000.
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Keruntuhan tekuk yang terjadi pada bangunan pengeringan karet ini akan
dimodelkan dengan dua analisis, yaitu analisis tekuk linear dan analisis tekuk
nonlinear.

1. Analisis tekuk linear

Analisis ini dilakukan untuk mengetahui mode dari keruntuhan tekuk

yang terjadi secara linear. Analisis statik dari struktur merupakan solusi dari

sebuah sistem persamaan linear, yaitu sebagai berikut:

Ku=r
dimana: K adalah matriks kekakuan struktur
u adalah vektor hasil perpindahan struktur
r adalah vektor pembebanan struktur

2. Analisis tekuk nonlinear
Analisis ini dilakukan untuk mengetahui jejak keruntuhan struktur dari
bangunan pengeringan karet. Analisis tekuk nonlinear ini sendiri terbagi ke dalam
dua buah analisis, yaitu analisis nonlinear geometri dan analisis nonlinear mateial.
a. Analisis nonlinear geometri
Ketika sebuah beban bekerja pada sebuah struktur dan menghasilkan deformasi
yang relatif kecil, maka hubungan antara beban dan deformasi adalah linear.
Namun ketika beban yang bekerja pada struktur menghasilkan deformasi yang
besar, maka hubungan antara beban dan deformasi adalah nonlinear. Perilaku
nonlinear ini dapat disebabkan oleh beberapa hal, diantaranya:
o Efek P-delta
Ketika struktur menerima pembebanan yang besar, dan terjadi perubahan
yang signifikan pada persamaan kesetimbangan pada saat awal dan setelah
struktur berdeformasi, meskipun deformasi yang terjadi relatif kecil.
o Efek deformasi besar
Ketika struktur mengalami deformasi yang besar, maka persamaan tegangan
— regangan yang biasa berlaku tidak dapat digunakan lagi, tetapi harus
menggunakan persamaan kesetimbangan untuk geometri struktur yang

sudah berdeformasi.
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b. Analisis nonlinear material
Ketika sebuah struktur diberikan pembebanan melewati batas leleh
materialnya, maka maka hubungan tegangan — regangan dari material struktur
tersebut tidak lagi linear.
Karena pada program komputer SAP2000 mengasumsikan bahwa
regangan yang terjadi pada setiap member-nya bernilai relatif kecil (=0), maka

efek dari nonlinear material dan nonlinear geometri tidak berhubungan.

3.2.4 Pemodelan Keruntuhan Struktur Bangunan pada SAP2000

Di dalam memodelkan keruntuhan tekuk pada struktur bangunan,
bangunan harus terlebih dahulu diberi sendi plastis, baik pada elemen struktur
kolom maupun baloknya. Hal ini agar keruntuhan tekuk terjadi secara nonlinear
material.

Setelah diberikan sendi plastis pada elemen struktur kolom dan baloknya,
maka yang selanjutnya dilakukan adalah membuat case keruntuhan tekuknya.
Untuk memodelkan keruntuhan tekuk secara nonlinear geometri, pada program
komputer SAP2000 dibuat load case, dengan spesifikasi sebagai berikut:

- Load case Type:Static

- Analysis Type:Nonlinear

- Geometric Nonlinearity Parameters: P-Delta plus Large Displacements
- Initial Condition: Continue from State at End of Nonlinear Case: DEAD
- Loads Applied: 1,2SUPER DEAD + a.1,6LIVE

(dengan nilai o berada dalam rentang 0 < o < 1)

Sedangkan untuk memodelkan pola keruntuhan tekuknya, pada program
komputer SAP2000 dibuat load case linear analysis buckling, dengan spesifikasi
sebagai berikut:

- Load case Type:Buckling

- Stiffnes to Use: Continue from State at End of Nonlinear Case: DEAD

- Loads Applied: 1,2SUPER DEAD + 1,6LIVE
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BAB 4

ANALISIS HASIL PEMODELAN

Setelah memodelkan

struktur

bangunan

dan kasus — kasus

pembebanannya ke dalam program komputer SAP2000, maka berikut hasil — hasil

yang didapatkannya:

M ot

Gambar 4. 1 Layout Struktur Bangunan Pengeringan Karet
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4.1 Analisa Hasil Pemodelan
4.1.1 Rasio gaya dalam ultimit terhadap kapasitas elemen sruktur

a. Hasil Pemodelan Model | — Pemodelan berdasarkan kondisi eksisting
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Gambar 4. 2 Rasio gaya dalam ultimit terhadap kapasitas elemen struktur

berdasarkan kondisi eksisting (tipikal untuk portal tepi)
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Gambar 4. 3 Rasio gaya dalam ultimit terhadap kapasitas elemen struktur
berdasarkan kondisi eksisting (tipikal untuk portal dalam)
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Pada pemodelan struktur bangunan menurut kondisi eksistingnya, dapat

dilihat bahwa baik pada portal maupun pada portal dalam telah terjadi overstress,

dengan nilai stress ratio-nya yang terbilang besar.

b. Hasil Pemodelan Model 11 — Pemodelan berdasarkan Shop Drawing
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Gambar 4. 4 Rasio gaya dalam ultimit terhadap kapasitas elemen struktur

berdasarkan Shop Drawing (tipikal untuk portal tepi)
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Gambar 4. 5 Rasio gaya dalam ultimit terhadap kapasitas elemen struktur
berdasarkan IMB 2010 (tipikal untuk portal dalam)
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Pada pemodelan struktur bangunan menurut shop drawing, dapat dilihat
bahwa pada portal tepi kondisi kolom — kolomnya masih relatif aman. Sementara
pada portal dalam telah terjadi overstress, dengan nilai stress ratio-nya yang
terbilang besar.

Jadi dari hasil rasio gaya dalam ultimit terhadap kapasitas elemen
struktur yang didapatkan, bisa disimpulkan bahwa struktur mengalami overstress
baik pada pemodelan yang menggunakan kondisi eksisting maupun pada
pemodelan yang menggunakan shop drawing yang terdapat di dalam IMB-nya.
Hal ini menunjukkan bahwa struktur bangunan tersebut memang tidak mampu
menahan beban yang direncanakan, meski tidak terjadi korosi pada elemen —
elemen strukturnya.

Dan jika dibandingkan antara hasil pemodelan model | dengan kondisi
nyatanya, terdapat kesesuaian, yaitu untuk kolom pinggir pada portal dalamnya,
keruntuhan tekuk tidak terjadi pada lantai 2 sampai dengan lantai 4. Gambarnya

adalah sebagai berikut:
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Gambar 4. 6 Rasio gaya dalam ultimit terhadap kapasitas elemen struktur

berdasarkan kondisi eksisting (tipikal untuk portal dalam)
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Tidak ada kegagalan
tekuk pada kolom It 2-4

Gambar 4. 7 Foto kegagalan tekuk pada kolom pinggir untuk portal dalam

4.1.2 Mode keruntuhan tekuk yang terjadi
Mode keruntuhan tekuk dicari untuk mengetahui pola keruntuhan tekuk
seperti apa saja yang mungkin terjadi pada suatu struktur bangunan.

a. Hasil Pemodelan Model | — Pemodelan Berdasarkan Shop Drawing
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Gambar 4. 8 Mode | dari keruntuhan tekuk linear struktur bangunan pada

kondisi eksisiting
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Dan berikut merupakan faktor tekuk untuk model 1, yaitu sebagai berikut:

Tabel 4. 1 Faktor tekuk model 1 dari program komputer SAP2000

OutputCase | StepType | StepNum | ScaleFactor

Text Text Unitless Unitless
Buckling Linear | Mode 1 0,728849
Buckling Linear | Mode 2 1,052367
Buckling Linear Mode 3 1,328281
Buckling Linear | Mode 4 1,639059
Buckling Linear | Mode 9 2,062707
Buckling Linear | Mode 6 3,012972

Jadi untuk terjadi Mode I diperlukan pembebanan sebesar:

0,728849(1,2DL + 1,6LL)

b. Hasil Pemodelan Model Il — Pemodelan berdasarkan kondisi eksisting

Gambar 4. 9 Mode 1 dari keruntuhan tekuk linear struktur bangunan menurut shop

drawing
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Dan berikut merupakan faktor tekuk untuk model 2, yaitu sebagai berikut:

Tabel 4. 2 Faktor tekuk model 1 dari program komputer SAP2000

OutputCase | StepType | StepNum | ScaleFactor

Text Text Unitless Unitless
Buckling Linear Mode 1 1,076748
Buckling Linear Mode 2 1,488754
Buckling Linear Mode 3 1,829297
Buckling Linear Mode 4 2,288333
Buckling Linear Mode 5 2,768637
Buckling Linear Mode 6 3,857587

Jadi untuk terjadi Mode I diperlukan pembebanan sebesar:

1,076748(1,2DL + 1,6LL)

Baik pada model 1 maupun model 2, keruntuhan tekuk yang terjadi pada

pada kolom — kolom lantai dasar bangunan pengeringan karet ini terjadi pada arah

sumbu lemahnya.

Dan berikut merupakan kondisi yang terjadi di lapangan:

Gambar 4. 10 Foto keruntuhan kolom pada lantai dasar
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Gambar 4. 11 Foto keruntuhan kolom pada lantai dasar

Gambar 4. 12 Foto keruntuhan kolom pada lantai dasar

Dari hal ini dapat diketahui bahwa kegagalan yang terjadi pada bangunan
pengeringan karet ini adalah keruntuhan tekuk pada arah sumbu lemahnya, sama

seperti yang dimodelkan.
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4.1.3 Keruntuhan tekuk yang terjadi

Keruntuhan tekuk yang terjadi akan diindikasikan oleh status dari sendi
plastis yang diberikan kepada kolom — kolom struktur bangunan pengeringan
karet tersebut. Berikut merupakan pemetaan kolom — kolom lantai dasar pada

struktur bangunan pengeringan karet:

¥7 37 79 121 163 205 247 289 331 373 415 457
y6 31 73 115 157 199 241 283 325 367 409 451
¥5 25 &7 109 151 193 235 277 319 361 403 445
yd 19 61 103 145 187 229 271 313 355 397 439
¥3 13 55 o7 139 181 223 265 307 349 391 433
y2 7 435 91 133 175 217 259 301 343 385 427
yl 1 43 BS 127 169 211 253 295 337 379 421
PORTAL nl x2 X3 nd %5 x6 X7 ] x9 pali] x11

Gambar 4. 13 Pemetaan kolom — kolom lantai dasar struktur bangunan

pengeringan karet

Pada setiap kolom, diberikan sendi plastis sebanyak dua buah sejarak 5%
dari ujung — ujung kolomnya. Karena panjang tiap kolomnya adalah tipikal, yaitu
sebesar 4 m, maka letak sendi plastis pertama (H1) berjarak 0,2 m dari pangkal
kolom, dan sendi plastis kedua (H2) berjarak 3,8 m dari pangkal kolom. Berikut
merupakan pemetaan sendi plastis pada kolom, agar memudahkan di dalam

melakukan analisis untuk ke depannya:

37H2 79H2 121H2 163H2 205H2 247TH2 289H2 331H2 373H2 415H2 457H2
vI 37H1 79H1 121H1 163H1 205H1 247H1 289H1 331H1 373H2 415H2 457H2
V6 31H2 72H2 115H2 157H2 139H2 241H2 283H2 325H2 367H2 408H2 451H2
31H1 73H1 115H1 157H1 139H1 241H1 283H1 325H1 367H1 409H1 451H1
" 25H2 B6TH2 109H2 151H2 193H2 235H2 277H2 319H2 361H2 403H2 445H2
25H1 67H1 109H1 151H1 133H1 235H1 277H1 319H1 361H1 403H1 445H1
va 19H2 B1H2 105H2 145H2 187H2 229H2 271H2 313H2 355H2 397H2 439H2
19H1 B1H1 105H1 145H1 187H1 229H1 271H1 313H1 355H1 357H1 439H1
v 13H2 55H2 g7H2 139H2 181H2 225H2 265H2 307H2 349H2 391H2 433H2
13H1 55H1 87H1 139H1 181H1 225H1 265H1 307H1 349H1 381H1 433H1
v2 TH2 48H2 81H2 133H2 175H2 217H2 259H2 301H2 343H2 385H2 427H2
7TH1 49H1 91H1 133H1 175H1 217H1 259H1 301H1 343H1 385H1 427H1
1H2 43H2 B5H2 127H2 169H2 211H2 253H2 295H2 337H2 379H2 421H2
\ 1H1 43H1 B5H1 127H1 169H1 211H1 253H1 295H1 337H1 379H1 421H1
PORTAL x1 x2 X3 x4 X5 X6 x7 x8 x9 x10 x11

Gambar 4. 14 Pemetaan sendi plastis pada kolom lantai dasar
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a. Hasil Pemodelan Model | — Pemodelan berdasarkan kondisi eksisting

Berikut, merupakan proses keruntuhan tekuk struktur bangunan
pengeringan karet ini:
I. Tahap | — plastifikasi

y7

y6

y5

ya

y3

y2

¥yl

PORTAL x1 X2 x3 x4 X5 X6 X7 X8 X9 x10 x11

Gambar 4. 15 Mulai terjadi yielding pada portal x2 dan x10
Pada tahap ini, sendi plastis pada sebagian besar kolom lantai dasar pada
portal x2 dan x10 mengalami tahap plastifikasi, atau dikenal juga dengan istilah
yielding. Tahapan ini terjadi ketika kolom — kolom lantai dasar menerima gaya
aksial ultimit sebesar kurang lebih 220 KN, atau besarnya kurang lebih sebesar
56,4% dari total pembebanan ultimit.

ii. Tahap Il — Immediate Occupancy

y7

yb

¥5

y4

y3

y2

y1

PORTAL x1 x2 x3 x4 x5 X6 X7 X8 x9 x10 x11

Gambar 4. 16 Mulai terjadi sendi plastis pada tahap Immediate Occupancy
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Pada tahap ini, sebagian besar sendi plastis pada kolom lantai dasar
memasuki tahapan immediate occupancy, dan ada beberapa yang memasuki
tahapan yielding. Pada tahapan yielding, sendi plastis belum mengalami kerusakan
apapun dan deformasi yang terjadi masih bersifat elastis, sementara pada tahapan
immediate occupancy, sendi plastis mengalami kerusakan yang minimal, namun
masih relatif kecil.

Pada kolom dengan nomor frame 187, 193, 229, dan 235 meskipun
posisinya relatif berada di tengah, namun tidak memasuki tahapan yielding

dikarenakan pada kolom — kolom tersebut dilewati oleh jalur lift.

iii. Tahap Ill — Life Saftey dan Collapse

y7

y6

¥5

y4

y3

y2

yl

PORTAL x1 x2 x3 x4 x5 X6 X7 X8 X0 x10 x11

Gambar 4. 17 Mulai terjadi sendi plastis pada tahap Life Safety dan Collapse

Pada tahapan ini, sebagian besar sendi plastis pada kolom lantai dasar
memasuki tahapan life safety dan ada beberapa sendi plastis yang mengalami
collapse, yaitu sendi plastis dengan nomor 103H2, 103H1, 313H2, 355H2,
355H1, dan 361H1. Beberapa sendi plastis memasuki tahapan immediate
occupancy, dan kolom — kolom yang dilewati oleh jalur lift sudah mulai
memasuki tahapan yielding. Pada tahapan life safety, sendi plastis mengalami
kerusakan yang relatif besar, sementara pada tahapan collapse, sendi plastis

mengalami keruntuhan
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iv. Tahap IV — Total Failure

45

y7

y6

¥5

y4

y3

y2

¥yl

PORTAL x1 X2 %3 x4 x5 X6 X7 X8 X9 x10

x11

Gambar 4. 18 Terjadinya total failure pada kolom 103, 313, 355, dan 361

Pada tahapan ini, semua sendi plastis kolom lantai dasar (yang

merupakan kolom dalam) telah memasuki tahapan yielding, dan beberapa sendi

plastis dari kolom — kolom lantai dasar telah memasuki tahapan total failure yaitu
sendi plastis dengan nomor 103H2, 103H1, 313H2, 355H2, 355H1, dan 361H1.

Jadi dari sini bisa diketahui, bahwa kolom yang gagal terlebih dahulu adalah

kolom dengan nomor frame 103, 313, 355, dan 361. Pada tahapan ini, besarnya

pembebanan yang diberikan adalah 1,2SUPER DEAD + «.1,6LIVE; dengan
0,6.

o =

Lalu dilakukan pengecekan titik leleh dan titik runtuh dari setiap sendi

plastis yang mengalami keruntuhan pertama kali.

Hinge Results
Plastic Deformation (m) Select Load Case

33, _: —,—'—'7 Buckling nonlinear 1,201 + U,Ss\j

I],_; Step r ﬂ
.33'_; ™ Current Hinge Data
- Hinge DOF m
P R
Plastic: U1 ,07
Plastic: U1 Max ,07
PlaicUlMin 0.
E Hinge State W .
-198,3 Hinge Status ’W |—
231 = ———-—"__Ff Plot Control Parameters

' [v Show Hinge Backbone .

[~ Scale for Full Backbone
Jw £idd Left and Right Borders
v Add Top and Bottom Borders

€6, 2
937
132,

Axial Force (kn)

165,73

O T R R A N R
J 85 84 72 B0 48 36 24 42 00 12x103
4 »
Mouse Painter Location  Horiz |-4 598E-03 Vet |67 676

Gambar 4. 19 Contoh pembacaan sendi plastis yang terjadi pada kolom
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Dan berikut merupakan tabulasi besarnya gaya aksial yang diterima oleh
sendi plastis pada kolom dengan tahapan — tahapan yang terjadi pada sendi plastis

tersebut:

Tabel 4. 3 Tabulasi besarnya gaya aksial pada sendi plastis dengan tahapan —

tahapan yang terjadi pada sendi plastis

Status Sendi Plastis B 10 LS C
Kolom Sendi Plastis P(KN) | P(KN) | P(KN) | P(KN)
103 103H2 220,64 239,18 257,71 | 279,83
103H1 221,33 239,87 258,41 | 279,52
313 313H2 220,93 239,95 258,97 | 275,75
313H1 - - - -
355 355H2 219,55 239,15 256,44 | 275,62
355H1 220,71 240,30 257,79 | 276,31
361 361H2 - - - -
361H1 220,93 239,95 258,97 | 276,86
Rata-rata 220,68 239,73 258,05 | 277,32
Keterangan:
B —yielding
10 — immediate occupancy
L — life safety
» — collapse

Dari sini bisa diketahui, bahwa keruntuhan tekuk terjadi pada struktur bangunan
pengeringan karet ini ketika besarnya pembebanan lembaran karet (beban hidup)

sebesar 60%.
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b. Hasil Pemodelan Model 11 — Pemodelan Berdasarkan Shop Drawing

Berikut, merupakan proses keruntuhan tekuk struktur bangunan
pengeringan karet ini:
I. Tahap | — plastifikasi

v7

Y6

¥5

vd

y3

y2

yl

PORTAL ®l x2 %3 x4 ¥5 xb X7 X8 x9 x10 x11

Gambar 4. 20 Mulai terjadi yielding pada portal x2 dan x10

Pada tahap ini, sendi plastis pada sebagian besar kolom lantai dasar pada
portal x2 dan x10 mengalami tahap plastifikasi, atau dikenal juga dengan istilah
yielding. Tahapan ini terjadi ketika kolom — kolom lantai dasar menerima gaya
aksial ultimit sebesar kurang lebih 330 KN atau besarnya kurang lebih sebesar
84,6% dari total pembebanan ultimit.

ii. Tahap Il — Immediate Occupancy

V'

Y6

¥5

yd

¥3

y2

yl

PORTAL xl x2 X3 x4 X5 x6 X7 e x9 %10 x11

Gambar 4. 21 Mulai terjadi sendi plastis pada tahap Immediate Occupancy
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Pada tahap ini, sebagian besar sendi plastis pada kolom lantai dasar
memasuki tahapan Immediate Occupancy, dan ada beberapa yang memasuki
tahapan yielding. Pada kolom dengan nomor frame 187, 193, 229, dan 235
meskipun posisinya relatif berada di tengah, namun tidak memasuki tahapan

yielding dikarenakan pada kolom — kolom tersebut dilewati oleh jalur lift.

iii. Tahap Il — Life Saftey dan Collapse

y7

yb

¥5

y4

y3

y2

yl

PORTAL x1 X2 %3 x4 x5 X6 X7 X8 x9 x10 x11

Gambar 4. 22 Terjadinya tahap life safety pada kolom 55, 61, 67, 391, 397, dan 403.

Pada tahapan ini, sebagian besar sendi plastis pada kolom lantai dasar
memasuki tahapan life safety dan ada beberapa sendi plastis yang mengalami
collapse, yaitu sendi plastis dengan nomor 61H2, 61H1, 397H2 dan 397H1.
Beberapa sendi plastis memasuki tahapan immediate occupancy, dan kolom —
kolom yang dilewati oleh jalur lift sudah mulai memasuki tahapan yielding.

iv. Tahap IV — Total Failure

y7

y6

¥5

y4

¥3

y2

¥yl

PORTAL x1 X2 x3 x4 x5 X6 X7 X8 X9 x10 x11

Gambar 4. 23 Terjadinya total failure pada kolom 55, 61, 67, 381, 397, dan 403
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Pada tahapan ini, semua sendi plastis kolom lantai dasar (yang
merupakan kolom dalam) telah memasuki tahapan yielding, dan beberapa sendi
plastis dari kolom — kolom lantai dasar telah memasuki tahapan total failure yaitu
sendi plastis dengan nomor 55H2, 55H1, 61H2, 61H1, 67H2, 67H1, 391H2,
391H1, 397H2, 397H1, 403H2 dan 403H1. Jadi dari sini bisa diketahui, bahwa
kolom yang gagal terlebih dahulu adalah kolom dengan nomor frame 55, 61, 67,
391, 397 dan 403. Pada tahapan ini, besarnya pembebanan yang diberikan adalah
1,2SUPER DEAD + «.1,6LIVE; dengan a = 0,9.

Dan berikut merupakan tabulasi besarnya gaya aksial yang diterima oleh
sendi plastis pada kolom dengan tahapan — tahapan yang terjadi pada sendi plastis

tersebut:

Tabel 4. 4 Tabulasi besarnya gaya aksial pada sendi plastis dengan tahapan —

tahapan yang terjadi pada sendi plastis

ol Status Sendi Plastis B 10 LS C
Sendi Plastis P(KN) | P(KN) | P(KN) | P(KN)
o 55H2 330,73 357,03 381,27 414,83
55H1 331,79 357,03 385,00 414,83
e 61H2 330,98 357,00 385,00 413,70
61H1 332,01 357,03 383,13 414,73
o 67H2 331,52 357,03 385,00 414,83
67H1 332,55 358,90 386,86 416,69
301 391H2 330,76 357,03 385,00 412,96
391H1 331,79 357,03 386,86 414,83
397 397H2 330,24 357,03 385,00 412,57
397H1 331,27 355,17 383,13 413,60
A03 403H2 330,79 357,03 385,00 412,97
403H1 331,82 358,90 385,00 412,96
Rata-rata 331,35 357,18 384,69 414,13
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Sehingga dapat disimpulkan, pada pemodelan struktur bangunan menurut
shop drawing-nya, bangunan pengeringan karet ini tetap mengalami keruntuhan.
Dan hampir pada semua kolom lantai dasarnya telah melewati batas pembebanan
elastisnya, terutama pada kolom dengan nomor frame. Hal ini berakibat terjadinya
pengurangan kapasitas kekuatan kolom sewaktu diberikan pembebanan di hari —

hari berikutnya.

Stress

Loading

Unloading

Strain

Gambar 4. 24 Kurva hubungan tegangan regangan yang tidak linear
Dan sudah tentu, korosi yang terjadi pada elemen — elemen struktur
bangunan pengeringan karet ini, khususnya elemen struktur balok dan kolom,
turut memiliki andil yang besar di dalam keruntuhan tekuk struktur bangunan ini.
Berikut merupakan rangkuman dari hasil pemodelan model 1 (menurut
kondisi eksisting) dan model 2 (menurut shop drawing):

Tabel 4. 5 Tabulasi hasil pemodelan model 1 dan model 2

Status Sendi Gaya Aksial P (KN) 0
\ n%
Plastis Model 1 Model 2

B 221 331 33,23
10 240 357 32,77
LS 258 385 32,99
C 277 414 33,09

Rata — rata 33

Dari tabel di atas bisa disimpulkan, bahwa pengaruh korosi terhadap kapasitas

kekuatan struktur kolom yaitu mengurangi sebesar +33%.
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BAB 5
KESIMPULAN DAN SARAN

5.1 Kesimpulan

Berdasarkan penelitian yang dilakukan, dapat disimpulkan:

e Kegagalan yang terjadi pada struktur bangunan pengeringan karet yang
dianalisis di dalam penelitian ini adalah benar merupakan kegagalan tekuk
yang terjadi pada kolom — kolomnya.

e Kegagalan yang terjadi disebabkan oleh pembebanan pada struktur bangunan
yang melewati batas elastisnya, yang menyebabkan kapasitas kekuatan struktur
kolom berkurang untuk jangka waktu ke depannya.

e Keruntuhan tekuk yang terjadi pada bangunan pengeringan karet ini juga
disebabkan oleh korosi yang terjadi pada elemen — elemen strukturnya,
terutama pada elemen kolom dan balok.

e Pengaruh korosi terhadap kapasitas kekuatan struktur kolom yaitu mengurangi

sebesar +33%.

5.2 Saran

e Melalui penelitian ini, dapat diketahui bahwa keruntuhan tekuk terjadi secara
tiba — tiba. Oleh karena itu, di dalam merencanakan suatu struktur bangunan,
sebaiknya memperhatikan faktor — faktor yang dapat menyebabkan suatu
bangunan mengalami kegagalan struktur, khususnya adalah kegagalan tekuk.

e Di dalam merencanakan pembebanan sebuah struktur bangunan, seharusnya
tidak melewati batas pembebanan elastisnya. Karena meskipun struktur
bangunan dapat bertahan, namun untuk jangka panjang kapasitas kekuatan
strukturnya akan berkurang, yang menyebabkan dapat terjadinya keruntuhan

tekuk di kemudian hari.
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Tutorial Pemodelan Keruntuhan Tekuk Struktur Bangunan
Pengeringan Karet dengan SAP2000

Berikut ini adalah tutorial pemodelan untuk mensimulasikan dan
menganalisis keruntuhan tekuk struktur bangunan pengeringan karet dengan
aplikasi perangkat lunak SAP2000. Analisis yang digunakan adalah dengan
analisis nonlinear statik. Langkah-langkah yang dilakukan adalah sebagai berikut :

PR T p————

g (g 1101101 P RSN W & S

4k

1. Membuat model baru, dengan langkah — langkah sebagai berikut:
Menu File > New Model > 3D Frames, lalu pilih kotak check box Use
Custom Grid Spacing and Locate Origin, lalu pilih Edit Grid...

2. Masukkan ukuran dari dimensi bangunan yang telah diketahui, yaitu
sebagai berikut:
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I8 Define Grid System Data

Edit  Eormat
Units Giid Lines
System Name ©
 Grid Data
GidID | Ordinate | Line Type | Wishiity | BubbleLoc | Bubbls Loc. =
1 w1 0. Primary Show End
2 2 4000, Frimary Show End
3 3 3000, Primary Shaw Erd D
4 wh 12000, Primany Show Erd B
5 5 16000, Frimary Show Erd B
g +6 20000, Prirary Show End I
7 7 24000, Primary Show End B
8 #8 25000, Prirnary Show End I ~
Y Grid Data Display Grids s
GridID | Ordinate | Line Tppe | Wisibilty | Bubble Loc. | Bubble Loc. = o o
1 il 0 Frimary Show Start
2 w2 4000, Prirnary Show Start
3 w3 8000, Primary Show Start -
4 v 12000, Frimary Show Start "~ Glueto Giid Lines
5 v 16000, Primnary Show Start
6 w8 20000, Frimary Show Start _
7 w7 24000, Primany Show Stan BubbleSics [9375
8
Z Grid Data 3
dsel o Defau
GidlD | Ordinate | Line Type | Visibilly | BubbleLoc. | -|
1 zl 0. Primary Show End
2 2 4000, Primay Show End P Ordnetze__|
3 ] a0, Fiimary Show End
4 z4 12000, Primary Show End
5 & 16000, Frimary Show End
g
7 | Cancel
™ N r @@~

Jika sudah, pilih OK.

3. Mendefinisikan material yang digunakan.

Menu Define > Materials... > Add New Material

Material Property Data

General Data

tass per Unit Y olume

L

|
’ Weight and Mazs

| I aterial Marme and Display Colar ]BJ Sampel . ‘ ‘
[ I aterial Type: I Steel LI |
I aterial Motes ModifyShow Mates... | |
| |
S— Units ]
Wieight per Lnit % olume ‘ IN, mm, C ’ﬂ

| B

I IsotropicToperty [ata
M oduluz of Elasticity, E
Faoisson's Ratio, U
Coefficient of Thermal Expansion, &

Shear Modulus, G

Other Properties for Steel M aterialz
Minimum *ield Stress, Fy

tinimum Tenzile Stress, Fu
Effective Yield Stresz, Fye

Effective Tensile Stress, Fue

[ Switch To Advanced Property Display

[ ok ]

Cancel

10000,
i
e
G
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Karena untuk pemodelan struktur bangunan pengeringan karet ini
menggunakan dua buah parameter, yaitu pemodelan berdasarkan kondisi
eksisting dan pemodelan berdasarkan shop drawing, maka ada dua buah
material yang didefinisikan, yaitu BJ Sampel untuk pemodelan
berdasarkan kondisi eksisting dan BJ 37 untuk pemodelan berdasarkan
shop drawing. Dan ada satu buah lagi material tambahan yang harus
didefinisikan, yaitu zinc alumunium, untuk material atap.

Mendefinisikan frame section untuk elemen — elemen struktur
Menu Deflne > Section Propertles > Frame Sectlons

I;‘Wldn Flange Section

‘ Section Name |IniF 2504125

I Section Maotes ModifesShow Mates... ‘j
| Properties . Prnperty Modifiers M aterial ———— R
‘ | Section F'rnperties._.J ’V Set Modifiers.. l [ | __| BJ Sampel |

| ) S WR L.

Dimengions 3 —

Dutside height [t3] 250, p
Top flange width (2] [15. W
Top flange thickness [ )
"Web thickness [ bw] r‘i—n_
| Battomflange vidth [120] [z | TR
4 Eottam flange thickness [ b TB‘——'

' | Diizplay Color ]_

‘U—,
o0

Dalam hal profil penampang ini juga terdapat dua buah parameter,
yaitu pemodelan berdasarkan kondisi eksisting dimana profil penampang
yang diinput merupakan yang sudah mengalami korosi dan pemodelan
berdasarkan shop drawing dimana profil penampang yang diinput belum
mengalami korosi. Pada input profil penampang yang sudah mengalami
korosi, Material yang digunakan adalah BJ Sampel. Sementara untuk input
penampag yang belum mengalami korosi, Material yang digunakan adalah
BJ 37.

Analisis keruntuhan ..., Geovanie Lukas Wijaya, FT Ul, 2011



Frame Properties

Froperties Click, to:

e s prgsE |mport Mew Property. . |

|C 100250

C 100=50 Add Hew Property... |
C 100=50 K.anopi 3
:w::: 1238:1?30 Add Copy of Property.... |
I'wWF 200:100 Fantilever

I'wiF 200100 Pingair b odify /S how Property.. |
Iw'F 250:125
I'wiF 250:125 Balok 112 arah » |
L B0=5065 arah =

L B0=50:5 arah v &

Fipe 2"

Pipe 3" l

R Gl

5. Mendefinisikan area section untuk atap
Menu Define > Section Properties > Area Sections...

Shell Section Data

|-y =

Section Mame |Zinc Alurn

Section Motes M odify/Show. .. ‘ | ‘

Digplay Color |—‘J ’

L
Shell - Thin B
¢ Shell- Thick

e T | ‘
" Plate Thick |

i

=

9

tembrane

Shell - Layered/Monlinear

b adify /S haw Lapenief |

h-iaterial -
M aterial Marne ﬂlf-\lum j
Matenial Angle 0.
Thickness
Membrane 0,35
Bending 035

Stiffness Modifiers
Set Modifers... |

Cancel |
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6. Mendefinisikan Load Patterns
Menu Define > Load Patterns...

Define Load Patterns

Load Patterns
Self wWeight

Load Pattern Name Multiplier

Auto Lateral
Load F‘attem

|DEAD

=

Click To:
Add New Load Pattern

Mndll_l,l Lnad Pattern

Delete Load Pattern

Show Load Pattern Motes..

Eancal

7. Mendefinisikan Load Combinations

Menu Define > Load Combinations...

Load Combination Data

—

Load Combination Mame [Jzer-Generated)

Mates

Load Combination Type

[1.2DL +1.6LL

Modify/Shaw Notes .|

Linear dd

Optiong —
Canvert tozer Load Comba |

] ~

Create Monlinear Load Case from Load Combo i

! r Define Combination of Load Caze Fesults —

Load Case Mame Load Caze Type Scale Factar
|DEAD _v|[Naninear Static 12
Monlinear Static
SUPER DEAD Lirear Static 1.2
LIVE Lirear Static 16
Cancel

Add
I codify
Delete

8. Cara memberikan pipa 3” (untuk diberikan beban) pada balok.

Yang pertama dilakukan ada memilih dua frame balok dalam arah sumbu
X, yang letaknya berdampingan. Lalu kedua frame tersebut di pisahkan
dengan menu Edit > Edit Lines > Divide Frames... Lalu divide frame
balok tersebut menjadi 3 bagian. Setelah selesai, berikan frame pipa 3”

pada joint — joint yang terdapat pada kedua frame balok tersebut, seperti

pada gambar.
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Lalu untuk memperbanyak pipa 3” tersebut, gunakan menu Edit >
Replicate... Perbanyak pipa 3” tersebut dalam arah x, y, dan z. Untuk arah
sumbu x, select terlebih dahulu frame pipa 3” yang akan diperbanyak. Lalu
pada menu Replicate, isi untuk besarnya increments dx: 4000 dan
increment data: 5. Untuk memperbanyak frame pipa 3” dalam arah
sumbu y, lakukan hal yang sama, namun isi untuk besarnya increments
dy: 4000 dan increment data: 9. Dan terakhir, untuk memperbanyak
frame pipa 3” dalam arah sumbu z, isi untuk besarnya increments dz:

4000 dan increment data: 3.

Cara Menginput Pembebanan

Pembebanan akan diberikan pada pipa 3” dan balok dalam arah sumbu x.
Jadi yang pertama dilakukan ada melakuan pemilihan frame pipa 3” dan
balok sebagai berikut: Select > Select > Properties > Frame Sections...
Pilih pipa 3” dan IWF 200x100. Karena frame yang diinginkan hanya

dalam arah sumbu x saja, maka lakukan perintah sebagai berikut: Select >
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Deselect > Select Lines Parallel To > Coordinate Axes or Plane...

Pada

check box Select Axes and Planes, ceklis pada Y Axis dan Z Axis seperti

pada gambar.

Select Lines

Select Lines That dre
(« Parallel To Specified [tems
" WNOT Parallel To Specified ltems

Compare Line Orientation Toa——————————

(o Coordinate Axes and Planes

Select xes and Planes

Coordinate Spgtem |GLD BaL

[ ¥ Az
[v 7 Axiz

" Line Objects
{ Areallbjects [ %Y Plane
[~ ¥Z Plane

Tolerance Angle in Degrees— —

e Pl
& Default [0.057 degrees) | g
= User&nale

Togole Digpl te Spstem |
Canicel 1

Setelah ini, dapat dilakukan input pembebanan, dengan perintah sebagai

berikut: Assign > Frame Loads > Distributed...

ada, baik Super Dead maupun Live.

Frame Distributed Loads

Input pembebanan yang

L-:uau:l Pattern Name

o+ |[uve

| i Load Type and Direction

* Forces O Moments

Coord Syps |GLOBAL

[
[

Direction | Gravity

Trapezoidal Loads

1. 2

5 =l

’~L|nits——

IN, mm,
|' Optiong—— 4
" Add to Existing Loads

f* Feplace Eristing Loads

(" Delete Existing Loads

3

Distance |0, 0,25

0,75 .

Load [0 0.

+ Relative Distance from End-|
[Irifarm Load

5.4

Load

[ |,

" Absolute Distance from End-l

Cancel

[ ok |

Analisis keruntuhan ...,

Geovanie Lukas Wijaya, FT Ul, 2011



10. Mendefinisikan Load Cases Buckling Linear
Menu Define > Load Cases...

Load Case Data - Buckling

Load Caze Mame Motes Load Case Type

Buckling Linear Set Def Hame | Madify/Show. .. | |Buc:k|ing j Design...

Stiffness to Use

" Zemo Initial Conditions - Unstressed State

(v Stitfress at End of Nonlinear Case DEAD 7

Important Maote:  Loads from the Monlinear Caze are MOT included
in the cument case

Loads Applied

Load Type Load Mame Scale Factor
| Load Patterr = ||SUPER DE# »|[1.2

Load Pattem LWE —J
b odify
Delete |

-—Dther Farameters T

Mumber of Buckling Modes B
Eigervvalue Convergence Tolerance I‘I JO00E-03 Eancal” |
= _ _

Load Cases Buckling Linear ini bertujuan hanya untuk mendapatkan mode
dari keruntuhan tekuk yang terjadi.

11. Mendefinisikan Load Cases Buckling Nonlinear
Menu Define > Load Cases...

Load Case Data - Nonlinear Static

Load Casze Name

(] . N
iBucKI\ng norlinear 1,20 Set Def Mame I

Naotes

Load Case Type

M odify/Show. . j|| Static | Design..

Ll
Iritial Conditions — —| Ana\ysls T_\Jpe L T
| " Zero |nitial Conditions - Start from Unstressed State  Linear
[oee =1 | .
(+ Continue from State at End of Nonlinear Case | DEAD = (= Nonlinear
Important Nate:  Loads from this previous case are included in the * Morlinear Staged Canstiuction
curentcase

Maodal Load Caze—— Geometric Monlinearity Parameters

| | AllModal Loads Appled Use Modes fom Case~ |MODAL = | | ® g

" P-Delt
Loads Applied s — e

{+ P-Delta plus Large Displ I
Load Type Load Mame Scale Factor la plus Laige Lisplacements
|Load Patter_+ ||SUPER DEZ ~ |[1.2

Load Pattern LIVE 1.28 Q
W odify

Delete

Other Parameters

LerrlAsfiestian Full Load Maodify/Show
Results Saved Multiple States tadit/S haw
Monlinear Parameters Drefault Modify/Show

Cancel

Dalam Load Cases Buckling Nonlinear ini, menggunakan Load
Application Load Control, dengan Loads Applied yang digunakan

menggunakan sistem trial and error, dengan kombinasi pembebanan
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12.

13.

sebagai berikut: 1,2SUPER DEAD + «.1,6LIVE; (dengan nilai o berada
dalam rentang 0 < a < 1). Hal ini dimaksudkan karena pembebanan yang
relevan untuk berubah dalam struktur bangunan pengeringan karet ini
adalah beban hidup nya saja, yang berupa beban lembaran karet.

Dan setelah dilakukan trial and error, ternyata didapatkan untuk
pemodelan berdasarkan kondisi eksistingnya, struktur bangunan
pengeringan karet ini mengalami keruntuhan ketika o bernilai 0,8 atau

pembebanan karetnya bernilai 80% dari total pembebanan maksimum.

Mendefinisikan sendi plastis pada kolom dan balok

Menu Define > Section Properties > Hinge Properties ...

Baik sendi plastis pada kolom dan balok menggunakan default untuk
material baja. Dan jenis sendi plastis yang digunakan adalah Deformation
Controlled (Ductile). Untuk sendi plastis pada kolom, DOF nya berupa P
Aksial, sementara pada balok DOF nya berupa M3.

Frame Hinge Property Data

(" Force Controlled [Brittle]
|
I i i [Deformation Controlled [Ductile]

! T el b
‘ I | lam 7 | |
| -ﬁ;e Type— - AN ._-—| |

| sl P

ModifpShow Hinge Property. .

i
|

Cancel |

Memberikan sendi plastis pada kolom dan balok
Menu Assign > Frame > Hinges...

Lalu baik pada kolom dan balok, berikan dua buah sendi plastis pada
kolom dan balok, sejarak 5% (dari panjang kolom atau balok) dari tiap

ujung — ujungnya.
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Frame Hinge Assiznments

Frame Hinge Aszignment D ata

Hinge Property Relative Distance
|Kolom ~|[no0s
F.olom 0,95 Add
odify
Delete

|'.f-‘«uta’ ae Assignme ata—

’ i Showr & e s ritarata.. |

(] | Cancel |

Setelah kolom dan balok diberikan sendi plastis, pilih kembali balok dan
kolom tersebut, lalu lakukan perintah: Assign > Frame > Hinge
Overwrites...

Frame Hinge Assignment Overwrites

Auto Subdivide — = = SE—
v Auto Subdivide Line Objectz At Hinges

Relative Length of Line Element &t Hinge 0.0z

Hinge Behawior- — —

| Do Mot &llow Hinges To Drop Load
[Does Mat Apply To Fiber Hinges)

- — -

Cancel |

Hal ini bertujuan agar hasilnya lebih optimal.

14. Me-run pemodelan
Menu Analyze > Run Analysis
Pada bagian Set Load Cases to Run, matikan Case Name MODAL,
sehingga status Actionnya menjadi Do not Run.
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Set Load Cases to Run

Click ta:
Case Name T}'Dé i Status Action Run/Do Not Run Case
Monlinear Static
Linear Static
Linear Static ;
Run/Dao Nat Run Al
Delete Al Results
Show Load Case Tree...
Analysiz Monitor Options R [ Model-Alive
O Bhways Show Run Now
" Mewver Show
% Shiow After |4 zeconds Cancel |
|

Setelah itu pemodelan dapat di—run.

15. Mengecek kapasitas kekuatan struktur terhadap kombinasi pembebanan
Menu Design > Steel Frame Design > Start Design/Check of Structure.
Namun sebelum melakukan pengecekan terhadap struktur, dilakukan dulu
pemilihan Load Combination sebagai berikut:

Menu Design > Steel Frame Design > Select Design Combos...

Design Load Combinations Selection

| Load Combinations for Design

{ Selact Type of Design Load Cambination :‘ ‘ ‘
Load Combination Type Strength -
i AN S B . b Sy
Select Load Combinations—— g —

| | List of Load Combinations Design Load Combinations

1.20L +1,BLL
| |
< F!emn_
| ‘ Show

Automatic Design Load Combinations

™ Automatically Generate Code-Bazed Design Load Combinations

Ok, | Cancel |

Lalu setelah dilakukan pengecekan terhadap struktur, dapat ditampilkan
stress ratio-nya sebagai berikut:

Menu Design > Steel Frame Design > Display Design Info...
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Display Steel Design Results (AISC-LRFD23)

{(+ Design Output P-4 Batio Colors & YWalues
" Design Input | J
Cancel |

16. Mengecek struktur bangunan akibat load case yang diberikan

Menu Display > Show Deformed Shape...

Deformed Shape

Caze/Combo—— ‘

Casze/Combo Hame |Buckling nonlinear v]

|
‘ Fultivalued Options - | ‘
| " Envelope [Max or Min)

| i+ Step IS % ||

. R _—l
| f* Auto

" Scale Factor I

N R o

| —Area Contours

| | [ Draw displacement conbours on area objects

O ptions

- 1N
i

|v Cubic Curve Cancel

[ Wire Shadow _| OF.
_ Cancel |

Pada bagian Case/Combo Name dapat diganti dengan tipe Load Case yang
ingin dianalisa seperti Buckling Linear dan Buckling Nonlinear.

17. Mengecek faktor tekuk struktur bangunan akibat load case Buckling
Linear

Menu Display > Show Tables...

Lalu pada kotak check box, dipilih: ANALYSIS RESULTS > Structure
Output > Other Output Items > Table: Buckling Factors.
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Choose Tables for, Display

Edit

= O] MODEL DEFINITION (0 of 72 tables selected) Load Patizms [Madel Det
#-[J System Data Select Load Patterns...
#-0 Property Definitions 4 of 4 Selected
# O Load Pattemn Definitions
&[] Other Definitions Load Cases (Resuls)
% O Load Case Definitions Select Load Cases
% [ Bridge Data £ of E Selected
# [ Connectivity Data

#- [ Joint Assignments Madify/Show Options
#-[] Frame Assignments
#-0 Area Assignments
# [J Options/Preferences Data
#-[0 Miscellaneous Data
= B ANALYSIS RESULTS (1 of 14 tables selected)
%O Joint Dutput
# [0 Element Output
=& Structure Dutput
# [0 Base Reactions
=B Other Output Items
(= Table: Buckling Factors

Options

r
™ Show Unfarmatted

Mamed Sets

Save Named Set.

Table Formats File. Current Table Formats File: Pragram Default

18. Mengecek status sendi plastis

Menu Display > Show Hinge Results...

Bagian select hinge berguna untuk memilih sendi plastis mana yang ingin
dicek. Untuk setiap member kolomnya sendiri terdiri dari dua buah sendi
plastis, di atas (H2) dan di bawah (H1).

Hinge Results

|
1

File Select
Select Hinge Hinge Location &nd Behavior Units
[ E1H1 [Kolom) | || Fiame Object Ei [Mme |
. Relative Distance 0.05
Show Hinge Property Definiiarn.. | | epFramiesien Defomnation Cantidled
Hinge Rlesuits
Plastic Deformation (m) Select Load Case
33,7 [ : Buckling nonlinear 1,2DL + 0,961 =
o st 7 =

Current Hinge Data

Hinge DOF [P+

P [Er—

Plastic U1 fo

Plastic UT Max [0

PlasicUTMin 0.

Hinge State o< N

Hings Status ~ Ato<=i0 |
Plot Control Parameters

¥ Show Hinge Backbone |

I~ Seale for Full Backbone

[ Add Left and Right Borders

[ Add Top and Bottom Borders

Axial Force (kn)

J 95 84 72 B0 48 36 24 12 00 1zw0f
4 »
Mouse Pointer Location  Hariz [1,045E-03 WVer [-33,

Agar memudahkan di dalam melakukan pembacaan, pada kotak check box Plot
Control Parameters dicentang pada bagian: Show Hinge Back Bone, Add Left
and Right Borders, Add Top and Bottom Bord
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LAMPIRAN - A

DATA - DATA STRUKTUR CRUMB RUBBER FACTORY
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Tampak Depan

Scale 1200
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LAMPIRAN -B

DATA - DATA STRUKTUR CRUMB RUBBER FACTORY
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LABORATORIUM STRUKTUR DAN MATERIAL
Departemen Teknik Sipil - Fakultas Teknik

Universitas Indonesia
Kampus UI Depok 16424, Indonesia (021) Telp. 787 4878 - 727 0029 (Ext.110/111) - 727 0028 (Fax)

No.Surat : 29179/H/LAB./FTUI/BS/VI/2010. HASIL PENGUJIAN TARIK PLAT BESI
Kegiatan Penelitian : LEMBAGA TEKNOLOGI FTUI
: PABRIK PT. MARDEC MUSI LESTARI
: PALEMBANG
NO. KODE SAMPLE BENTUK sampLe | DIMENSI SAMPLE PENAPANG |PAMIANG UKUR AL o oy E %] KETERANGAN
i y [mm] {mm] [mm] (mm]) [N/mm?) (N/mm’]
1 SIKU 50 PLAT w=13.00 | 61.10 50 10.75 660 470 21.50
t =4.70
2 WF 150 PLAT w=1290| 69.66 50 11325 560 410 22.50
t=5.40
3 WEF 200 PLAT w=1245| 59.76 50 14.60 420 330 29.20
t=4.80
4 WF 250 PLAT w=1250| 66.25 50 12:25 480 330 24.50
t =5.30
FTVH
DETAIL GAMBAR :
Panjang Ukur =S Depok, June 16, 2010.
g 1 /... Kepala Laboratorium
—\—lA——’_/—
ISP oy SN H :‘;”1/7/%)/1. S
Pot. AA 7
r. Ir. Elly Tjahjono, DEA
Ditestoleh ' : BAS
Diperiksa oleh :
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